The Why To Of My How

A genius is just a talented person who does his homework

—Thomas A. Edison




Opportunity is missed by most people because it is dressed in overalls

and looks like work.

—Thomas A. Edison

I have covered a lot of territory up to this point. So I am
going to review some of the things that [ have discussed in
previous chapters.

+ Astill photograph is called a still photograph because the
picture does not move, not because the objects in the
picture were not in motion at the time of capture

¢ Visualize the finished image in your mind’s eye as you are
making the capture. Do not go out with a camera with
preconceived notions of what you will capture; be open to
possibilities.

¢ Do not take pictures; be taken by your pictures.

¢ Photoshop is not a verb. It is a noun.

¢ Photoshop should be used as an emery board, not as a
jackhammer. “Did you do that in Photoshop?” should be a
question, not an accusation.

¢ Getitright in the camera. If it does not look good
through the lens, it will not look good coming out of the
printer.

¢ Because the printer is a “default” device, the print is only
as good as the file that you send to it.

* RGBis not a color; it is a formula to mix color.

¢ If you can see something, it has color. Gray is a color and
“black is the queen of all colors.”

¢ Practice doesn’t make perfect. Perfect practice makes per-
fect. Perfect practice comes from practicing at practicing.

+ Workflow starts at the point of capturing the image.

+ Workflow is a dynamic experience. No two images are the
same; therefore, no two workflows are the same. Be adap-
tive; always pro-act rather than react

¢ The more you know about the middle, the more informed
your decisions can be at the beginning, because every-
thing you do is in service of the print (the end), and the
print is your voice.

¢ Abelievable improbability is better than an improbable
believability.

The human eye is an amazing biological optical system
that can see motion; a digital still camera cannot.

An image is more about the quality of blur, or bokeh,
than it is about focus.

When using a fixed sensor/film plane system such as an
SLR or DSLR, it is optically impossible to have two objects
at different distances in focus at the same time.
Stopping a lens down does not ensure that objects at dif-
ferent distances from the sensor/film plane will all be in
focus at the same time.

If you want to have multiple objects in focus, you need to
have captured a separate image for each object that you
want in focus.

The expansion of the dynamic range of exposure through
multiple captures (HDR) is a small part of the extension
of dynamic range (ExDR).

Shape is the enemy of color.

A pattern is interesting, but a pattern interrupted is more
interesting.

If you want the eye to remember color over shape, cause
shape to become the unwitting ally of color.

The viewer looks at a photograph with two “eyes,” the
unconscious and conscious one. The conscious eye inter-
prets the image that the unconscious eye (the biological
optical recording device) sees.

The unconscious eye “sees” in a predictable manner. It
first recognizes light areas and then moves to dark ones,
sees high before low contrast, records high before low
sharpness, notices focus before blur, and focuses on high
color saturation before low.

CJ Elfont’s Isolate Theory explains the interrelationship
of the elements (or isolates) in a photograph and, when
correctly applied, causes the unconscious eye to move
across an image the way that the photographer intends.
Consider light a tangible thing so that what you photo-
graph is not the subject, but the light as it falls on the
subject.

Three of the four key components of any photograph are
light, gesture, and color.
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NOTE: In the third book of this series, I will discuss the
fourth key component; time. In the original Welcome to Oz,
the chapter discussing this was the last. During the rewrite,
I expanded the discussion of time so that it became too large

to include in this book.

These are some of the key points in this book. But there is
more to creating an image than the four lessons contained
within the pages of Welcome to Oz 2.0. There is also why and
how to process RAW files, how to scale images, why and how
to color manage an image and calibrate your monitor(s), and
what to do to an image before printing it.

ONE: Processing RAW Files.

[ 'am a Nikon shooter and I use Capture NX2 to process my
RAW (.NEF) files. If you are Nikon shooter read on, if you use
another system, feel free to move on to the color management
section later in this chapter.

In addition to Capture NX2, I also use Adobe Bridge and
Adobe Lightroom, but not in the initial processing of my
RAW files.

I believe that Lightroom is as inspired a piece of software
as is Photoshop. Although I find Apple’s Aperture elegant to
look at, I find it less useful than Lightroom. Additionally, Ap-
erture is not cross-platform, and although I am an Apple user,
I do work with those who are not on the “fruit” diet when it
comes to operating systems. I use Lightroom to catalogue,
view, and edit my images. Once [ have finalized what I want
an image to look like using Photoshop and have a set of files
from which to print, I use Lightroom to actually do the print-
ing. (I do use Adobe Bridge to launch Capture NX2 once I
have made my choices of the images on which I am going to
work because Lightroom does not allow me to launch a third
party RAW processor without converting the file to a TIFF.)
Lightroom does something else that I feel is very important;
it allows me to tether directly from my camera to my com-
puter. Both Aperture and Lightroom do this, but Capture

NX requires that you have an additional piece of software
(Nikon Camera Control) if you want to shoot directly into a
computer.

Therein lies the rub. No matter whose camera system you
use, the manufacturer’'s RAW processor gives you a better
looking file if it is processed though their software. The issue
is that, frequently, the manufacturer’s software is so difficult
to use that the potential file quality benefit is not worth the
hoops through which you have to jump. So, if you are a non-
Nikon shooter, Lightroom and Adobe Camera Raw offer you
the best solution to process your files.

Capture NX2 vs. Lightroom 3 vs. Aperture vs.
Adobe ACR and Bridge

Lightroom 3 is an incredible piece of software as a browser,
for making web pages for clients to view on line, for upload-
ing to social media sites, for making slide shows with music,
for working with third party plug-ins, and it is really easy to
use for printing, all in a cross-platform solution. It also nicely
batch processes. On the down side, it does not provide a net-
work database solution, it does not allow you to use any RAW
processor other than its internal module (though it does take
third party plug-ins, but to use them you have to render the
RAW file on which you are working into a TIFF) and you can-
not export the slideshows you create to a Quicktime movie.
For the most part, Adobe Camera Raw is the Develop mod-
ule in Lightroom, but it is built into Photoshop. Adobe Bridge
does a lot of what the Library module of Lightroom does, but it
does not have a database capability. It does, however, allow you
to do something very significant that no other browser solution
does. It allows you to launch a third party RAW processor.
Aperture 3 is a beautiful piece of eye candy, but it is not
as easy to use and does not have as intuitive a layout as does
Lightroom. It does take third party plug-ins, but to use them
you have to render the RAW file you are working on into a
TIFF, and it does not allow you to choose a third party RAW
processor. On the other hand, it does allow you to import
your iPhoto library into Aperture, which means that you can
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import all of the slide shows that you have made, including
those that have been fit to music. Additionally, it allows you
to open up these slide shows and fine tune the timing of
each slide. Aperture 3 also allows you to export a slide show
as a Quicktime movie, which means that you can use it on
multiple machines. (This is something iPhoto does not do as
easily. Also, iMove does not have a fit-to-music feature, which
would be nice to have.) Aperture 3 also allows you to build
web pages. It is not, however, a cross-platform solution and
is the noisiest of the RAW processors discussed with the least
satisfactory color rendition.

The bottom line is that I use Aperture 3 to make fine
adjustments to my slide shows and then I export them as a
Quicktime movie.

Capture NX2 is not the best browser on the planet, (Light-
room 3 has that distinction), and you cannot make slideshows
(though it does batch process—a function whose speed can
be adjusted). It is not networkable, and, because it is a third
party solution in the sense that it works only on Nikon RAW
files, it does not allow for the launching of another RAW
processor.

I do not use the Develop module in Lightroom or ACR to
process my RAW files. I think that the layout and design of
the Lightroom Develop module is brilliant for editing and
that the user interface (U) is easier to move through than
either Photoshop or Capture NX. Lightroom’s Develop mod-
ule also does batch processing better than NX2. But when it
comes to processing my images, I can produce a cleaner, bet-
ter rendered file using Capture NX2.

As a Nikon shooter, [ find that Capture NX2 does a better
job at processing my RAW files than any RAW processor on
the market today and this is why [ use it exclusively for this
purpose. Look at two files: a visible spectrum, color image
captured with a Nikon D300. The image was processed in
Lightroom 3, Aperture 3, and Capture NX2. All the images
were processed “As Shot,” which (to me) means there is no
room for interpolation—what the image looks like when I
view it on the LCD of the camera is what [ should see when
[ process it in software. However, you can see that there is a

difference in color, sharpness, noise reduction, and contrast
when you compare the images processed by Capture NX2 with
those processed by Lightroom 3 and Aperture 3. The Capture
NX2 images were the same as they were when [ viewed them
on the LCD of the camera. Compare the overall images when
processed in Capture NX2, Lightroom 3, and Aperture 3
(Figures 5.1.1, 5.1.2 and 5.1.3).

To compare noise and the detail, look at the close up of
the clouds and the building in Figures 5.1.4, 5.1.5 and 5.1.6.

6 WEeLcoME 1o Oz 2.0



FIGURE §.1.1 The whole image when processed FIGURE g.1.2 The whole image when processed FIGURE 5.1.3 The whole image when processed
through Capture NX2 through Aperture 3 through Lightroom 3

FIGURE §.1.4 The details and sky when processed FIGURE 5.1.5 The details and sky when processed FIGURE 5.1.6 The details and sky when processed
through Capture NX2 through Aperture 3 through Lightroom 3
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TWO: Color Calibration

“Before you buy your next printer, the single greatest
impact that you can have on your prints is to calibrate your
monitor.” After introducing myself as the host of the Epson
Print Academy, those were the words I spoke at every Epson
Print Academy for the four years that I hosted them. Do you
want even better looking prints? Use paper specific profiles
when you print. Do you want more accurate color from your
images? Shoot an image with a ColorChecker target whenever
possible. Let me elaborate.

Wh)/ Calibrate a Monitor?

1. The next time you are in a store with a large television de-
partment, notice those televisions that are playing the same
thing. Do they all look the same or do they differ? More than
likely, not only will they all look different, but televisions from
the same manufacturer that are the same model will also look
different from each other.

2. Next time you are on an airplane, walk down the aisle and
look at the TV screens on which your fellow passengers are
watching the same in-flight entertainment. These screens are
definitely the same model from the same manufacturer and
they will all look different.

The reason for all these differences is that the screens (or
monitors) are all un-calibrated.

On an un-calibrated monitor, you have no way of knowing if
the reds and blues that you see are true to the reds and blues
that were present when you captured the image. Using a cali-
bration device (a piece of hardware that sends measurements
to your software) allows you to get what you see on the moni-
tor to most closely match what you saw when you clicked the
shutter.

If you were to go for a walk at night and (from the street
only—I do not want you to be arrested) look at houses with
the television on and the lights off, you would see that the

color of the light coming out of the window would have a
decidedly bluish cast. When you make adjustments to the
color of an image on an un-calibrated monitor, you are adding
the appropriate amounts of color to compensate for the un-
wanted blueness of the monitor. Printers are default devices,
remember? They print only the data that they receive. When
you compensate for the unwanted blueness of your monitor,
your print will have a magenta-ish color cast — not at all what
you see on the screen. For the most part, if you use hardware
to calibrate your monitor, what you see on the monitor will be
what is printed.

Why Use a Printer/Paper Proﬁ]e?

Simply put, a printer profile is a measurement of patches

of color, or a target, (Figure 5.2.1, X-Rite iSis with target)
printed on a specific paper that, when measured by a hard-
ware device, shows how much ink the paper can take and
what known color values when printed on any given substrate
will look like. A printer profile is used to bring the measured
values back in line with the known color values that are stored
within the profiling software.

The best prints that you can make are made with paper pro-
files specific for your printer. All printers ship with generic
paper profiles. These are profiles that are made by averaging
the profile measurements of many printers of the same type
to create a profile that will work on many (but not all) print-
ers. The best thing you can do is to create a custom, printer-
specific, paper profile, which is no longer as expensive or time
intensive as it once was. If, however, you prefer not to do this,
then you are best served by using the generic profiles pro-
vided by the manufacturer.

A good reason to use printer-specific paper profiles is so that
you can do “soft proofing” of the image in Photoshop. Soft
proofing is when you “load” the printer-specific paper profile
into Photoshop so that you can see on your calibrated moni-
tor how the colors will look on the paper before you actually
commit the image to a physical print.
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FIGURE 5.2.1 The X-Rite iSis
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FIGURE §.3.1

The Progfis in the Sgﬁ Procﬁn(q

To keep your workflow efficient, do all of your aesthetic ad-
justments to your image in either 16-bit ProPhoto color space
or, if you must, in 8-bit Adobe RGB color space. Once you like
the way the image appears, follow these steps.

1. Save the layered file as a .PSD or .PSB (depending on the
files size — for 2 gig and below, use .PSD; and for 2 gig and
above, use .PSB).

2. Then, flatten the image. Select “Save as” and save the
image as a Tiff file (.tif).

NOTE: In my workflow, I save the file as a “Lossless” Genu-
ine Fractal file (.stn). I will discuss the merits of fractal scal-
ing shortly.

3. Duplicate the file (Image > Duplicate) (Figure 5.3.1).

4. Rename the file by adding the name of the paper on which
you will print. For example, I add “CC” for color corrected

and “CPN” for Cold Natural, so the name of the file would be
LILY1_CC_CPN.tif.

5. Save the file.

6. Making sure the newly saved file is the active one, go to
View > Proof Setup > Custom (Figure 5.3.2).

V/[L78 Window Help |
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FIGURE §.3.2
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7. From the Device to Simulate pull-down menu, select the
profile you wish to simulate (Figure 5.3.3) and the rendering
intent you have chosen for this image.

You now have an image as you envisioned it and one that
shows how your vision is going to print on a given paper. No
two images are the same, so no two adjustments will ever be
the same. After I did my adjustments to the image to compen-
sate for the way the image will print, this is what it looks like
(Figure 5.3.4). What I did to correct the image was:

I created a Curves adjustment layer, named it COLOR_COR-
RECT, chose the Color Blend mode, then adjusted the curve
to match the original, non-soft proofed version, and then

did the appropriate brush work. Here are the Curves adjust-
ment layer (Figure 5.3.5), the layer mask (Figure 5.3.6), and
what the image looked like after brush work and correction
(Figure 5.3.7).

I created a Curves adjustment layer, named it COLOR_DARK,
chose the Luminosity Blend mode, then (with the COLOR_
CORRECT Curves adjustment layer turned on), adjusted the
curve to match the original non-soft proofed version, and
then did the appropriate brush work. Here are the Curves ad-
justment layer (Figure 5.3.8), the layer mask (Figure 5.3.9),
and what the image looked like after brush work and correc-
tion (Figure 5.3.10).

FIGURE §.3.6 The layer mask
for COLOR_CORRECT

FIGURE §.3.7 The image
after the brushwork for
COLOR_CORRECT
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I created a Hue and Saturation adjustment layer, named it
CORRECT _SAT, left the blend mode set to Normal, then ad-
justed the saturation to match the original non-soft proofed
version (with the COLOR_CORRECT and COLOR_DARK Curves
adjustment layers turned on), and then did the appropriate
brush work. Here are the Hue and Saturation adjustment
layer (Figure 5.3.11), the layer mask (Figure 5.3.12), and
what the image looked like after brush work and correction
(Figure 5.3.13).
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FIGURE §.3.8 FIGURE §.3.9 The layer mask

for COLOR_DARK

FIGURE §.3.10 The image after the
brushwork for COLOR_DARK

I created a Vibrance adjustment layer, named it ENHANCE_VI-
BRANCE, left the Blend mode set to Normal, then adjusted
the vibrance and saturation to match the original non-soft
proofed version (with the COLOR_CORRECT, COLOR_DARK
Curves adjustment layers, and the CORRECT_SAT Hue and
Saturation adjustment layer turned on), and then did the
appropriate brush work. Here are the Vibrance adjustment
layer (Figure 5.3.14), the layer mask (Figure 5.3.15), and
what the image looked like after brush work and correction
(Figure 5.3.16).
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FIGURE §.3.11 FIGURE §.3.12 The layer mask

for CORRECT_SAT

FIGURE §.3.13 The image after the
brushwork for CORRECT_SAT
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FIGURE §.3.16 The image after
CORRECT_SAT

FIGURE §.3.18 The layer mask
for ENHANCE_VIBRANCE

FIGURE §.3.15 The layer mask
for CORRECT_SAT
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FIGURE §.3.17

FIGURE §.3.19 The image after
ENHANCE_VIBRANCE

I created a Curves adjustment layer, named it CORRECT_BG,
left the Blend mode set to Normal, then adjusted the satura-
tion to match the original non-soft proofed version (with
the COLOR_CORRECT, COLOR_DARK Curves adjustment lay-
ers, the CORRECT_SAT Hue and Saturation adjustment layer,
and the ENHANCE_VIBRANCE Vibrance adjustment turned
on) and then did the appropriate brush work. Here are the
Vibrance adjustment layer (Figure 5.3.17), the layer mask
(Figure 5.3.18), and what the image looked like after brush
work and correction (Figure 5.3.19).

The images side by side (Figures 5.3.20 and 5.3.21)

NOTE: A great resource that goes into incredible depth on
this topic is John Paul Caponigro’s tutorial DVD, “The Art
of Proofing.” You can find more information at http://acme-

educational.com/jpc/index.html

FIGURE §.3.21 The image after the

FIGURE §.3.20 The image before
the soft proof

soft proof corrections
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Wh)/ Are My Prints So Dark?

You will see the blackest black that a monitor can produce
when it is turned off. Actually, this is not black at all but a
very dark gray with a slightly greenish cast. Black on a moni-
tor is produced through an illusion of contrast. The dark areas
on a monitor appear to be black, because the areas around
the dark areas are much lighter. If you were to create a layer
in Photoshop, fill it with black, hide all of the pallets and bars
(Tab key), and put your hand next to the monitor, your hand
would be illuminated. To some degree, you could completely
illuminate a dark room with the light of a monitor. If, how-
ever, you were to stand in that same darkened room with a
print of the black layer that was on the monitor, you would be
completely in the dark. That is because a monitor is transmis-
sive and a print is reflective. A monitor radiates light and a
print absorbs it. That is why, even though you have calibrated
your monitor, and are using printer-specific profiles (and soft
proofing), your prints may turn out to be darker than they
look on your monitor. The primary reason for this is that the
appropriate luminance setting was not chosen when you cre-
ated your monitor profile. In other words, the profile that you
created was for a monitor that was too bright.

There are two ways to correct for this: use polarized profiles
or adjust the image via a Curves adjustment layer set to

the Screen blend mode. You might try using polarized pro-
files, but they can be created only on one machine that cost
$8,000.00 when it was new and that machine has not been
made for several years

The Screen blend mode halves the density of the image mean-
ing that the entire image will become lighter. You may find
that there are areas that you do not want to be lighter or as
light as a Screen blending mode Curves adjustment layer
makes the image. There are two ways to correct this. One is

to use the attached layer mask to selectively adjust the image,
and two is to use layer opacity. I find that the amount of layer
opacity that I need to lighten the image generally falls be-
tween 2 and 20%.

Should I Use a ColorChecker Target When I Shoot?

Whenever possible, I capture an image with a ColorChecker
Passport. It is a pocket-sized, self-standing case with three
photographic targets. When I am shooting people and have
some control of the shoot, I will have the subject hold the
target while I make a capture, and then I will shoot normally.
If the light changes, I will grab another capture with the target
before I resume shooting without it.

When I am shooting nature, I will make a capture with the
ColorChecker in the shot. Shooting street shots is a little
more problematic, so I tend not to use the ColorChecker in
these situations.

Using a ColorChecker gives me a calibrated neutral gray, a
warm gray and a cool gray and a calibrated pure white.

NOTE: I prefer to take my black point from the actual
image. I find this gives me a truer black. The neutral gray
is helpful when I have a non-existent midtone or a midtone

that is not really a neutral one.

[ use a ColorChecker so that I can be guaranteed to have mea-
sured values in an image that I can later sample for White,
Mid- and Black Point Curves correction layers should I decide
to do so. In this way, I get both accuracy and control, and all
it costs me is to capture an image with the target in it from
time to time through the course of a shoot. Here is the Color-
Checker Passport (Figure 5.4.1) and images that are uncor-
rected and corrected with one (Figure 5.4.2).

FIGURE §.4.1 The Passport
ColorChecker
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FIGURE §.4.2 The Passport with corrected images

FIGURE §.5.1 The X-Rite il systemv

FIGURE §.5.2 The Color Munki

Another Calibration Toy That Does a Great Job

In my studio, I use the X-Rite i1One system (Figure 5.5.1).
When I am on the road, which is most of the time, I travel
with an X-Rite ColorMunki Photo. (Who comes up with these
names?) The Color Munki Photo (Figure 5.5.2) allows me to
calibrate my monitor, a projector, and make printer profiles.

[ can also make image specific profiles based off the printer
profile that is created for a specific paper — a very cool thing
indeed. (You can watch a quick time of this entire process at
www.XRitephoto.com/versace.)

THREE: Take Two Tablets. ..

The power of a tablet or a Cintiq is more than simply allowing
you to draw with its pen, adjust its pen’s sensitivity, and tilt or
rotate the pen. The real power of a pen tablet or pen display is
in its ability to optimize the pen’s functionality and to enable
you to customize it to your workflow through the use of its
driver, express keys, and touch strip. All of this functionality
of the Wacom driver is one of the most overlooked aspects of
the tablet-based approach to image editing. In this section, I
hope to change that and I will also discuss the philosophy of
setting up and working with a tablet.

I believe that for image retouching, photo manipulation,
creating image maps, making accurate layer masks, and just
speeding up workflow, you should be using a tablet instead
of a rodent with its tail plugged into a USB port, otherwise
known as a mouse.

Almost every keyboard command and as many of the other
repetitive things that you have done throughout the course
of this book are now programmed into a set of presets (both
left-handed and right-handed) for the Intuos 4 tablets and
the 21” Cintigs (both the current and last generation devices)
that you can install into your computer (located on the main
download page for this book). I have also created a radial
menu set of presets if you are using an Intuos 3 (and below)
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tablet or the 12”Cintiq. These are the presets that I use every
day in my workflow and they have been optimized with the
help of Joe Sliger. Joe is Adobe certified for Photoshop and
the technical applications specialist from Wacom. You can
now download those presets from the download site for this
book. There is also a PDF that shows you how to configure
your tablet/Cintiq, how to load my tablet presets, and that
lists my Photoshop shortcuts.

Tablet Philosophy and Tablet Button-ology

In the process of developing the Oz 2.0 tablet presets, [ have
learned that, although I am considered a tablet power user
by many, I did not know the true power of the tablet because
[ was using only its obvious functions. To best understand
how to use a tablet, you need to know how the designers first
conceptualized the switches in the pen, the express keys, the
touch ring (or touch strip if you are using a Cintiq like I do),
and the radial menu.

Determining how to best set up a tablet requires you to con-
sider what you are trying to accomplish when you use a tablet
and can be grouped into two types: events and the hierarchy
of how to use a tablet, or, as the wizards of Wacom refer to

it, the “Tablet Philosophy.” There are three types of events:
Corded, Keyboard blasts, and Incrementals. The hierarchy of
tablet uses (the tablet philosopy) can be broken down into the
primary, secondary and tertiary objectives depending on what
you are doing with the tablet within Photoshop.

Types of events

¢ Corded—uses modifier keys that you hold down while
doing another task. Examples are using Option + Shift +
Click to drop a sample point, using Option / Alt + Click
to define a source point, and holding the space bar while
click-dragging to navigate through an image.

+ Keyboard blasts—are traditional short cuts in which
you hit a series of keys to cause an event to take place.

¢ Incrementals—are any action that involves increasing
or decreasing or is directional (up, down, or side to side).
Examples are increasing or decreasing brush size, or

zooming in and out of an image.

Tablet Philosophy (Hierarchy of Tablet Uses)

¢ Primary—all things that you do with the pen while the
pen is actively on the image

¢ Secondary—all things (commands) that you do with
your non-dominant hand while the pen is on the image

¢ Tertiary—all express keys and express strips for which
you need your dominant hand. These functions (e.g.,
Save, Save As, and Open) have nothing to do with where
the cursor is on the screen, because you have to take your
dominant hand (the one with the pen) away from the
image to use them.

The Sliger Multiple Monitors Methodology with a
Tablet or Cintiq
Displays need to be in extended format, with the primary dis-

play (most likely the Cintiq, since that is where the pen works)
set for your dominant hand. (Figure 5.6.1)

FIGURE 5.6.1 The two monitors set up for a right-hand

dominant workflow
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Here is how to set this up.
1. Open an image for editing.

2. From the Window menu in Photoshop, select Arrange >
New Window for image name.

3. By default, Photoshop will grab the tab for the second
view of the original image and drag it to the other display.

NOTE: You can easily do this on the Cintiq if you have con-
figured one of the express keys to the “Display Toggle” func-
tion. This means that the pen on the Cintiq can temporarily

access both displays which is how mine is set up.

FIGURE §.7.1 Incorrect holding style

F1Gure §.7.2 Correct holding style

4. Once the image is on the other screen, release it, press the
F key, change your screen mode, and Control / Command O to
go to full screen. Then, hit the display toggle button again and
click back on your Cintiq. The cursor should map to the pen
again, and leave the other image alone. The non-Cintiq moni-
tor is now a reference image.

Work on your Cintig—zooming, panning, and retouching all
the while looking at the effects on the overall image on your
second display.

Proper Pen Holding Tecbnique

Many people hold the pen so that they can use the side switch
with their index finger (Figure 5.7.1). The problem with this
approach is that it is uncomfortable and difficult to reach the
top of the side switch without being a contortionist. For this
reason, [ hold the pen so that the side switch is in the cavity
under my hand, but so that I can roll the pen into my thumb
to easily reach either end of the side switch (Figure 5.7.2).

How to Get Better at Using Your Tablet

To learn how to be more proficient using a tablet, unplug your
mouse for several days. The issue is one of habitualization
and muscle memory. If your mouse is handy, you will likely go
back to it. Make yourself learn to use only the pen. Let some
serious muscle memory begin as you use the tablet and, after
a few days, hook the mouse back up.

Pen to Tablet: The Roadmap qu)/ Mind, The Oz 2.0
Tablet Settings

Alot of work went in to these presets, but before you install
the Oz 2.0 Tablet Settings there are things you should know.
Please read the following carefully.

¢ [have added keyboard shortcuts to Photoshop and modi-
fied only a few, so you will need to install my Photoshop
keys file to fully take advantage of the Oz 2.0 Tablet
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Settings.

¢ The Oz 2.0 Wacom tablet presets contain all of the key-
board commands used in this book.

¢ There are presets for Windows and Mac, specifically Mac
0S10.6.4 and above, and Windows 7. Because I do not
have Windows XP, I cannot say if they will run on that
Os.

¢ Ifyou are a 21° Cintiq user, there are presets for both
left-handed and right-handed users.

¢ Ifyou are a tablet user (using Intuos 4 or any tablet that
can access the radial menu), you are in luck because the
Oz 2.0 Wacom presets will work.

¢ The Oz 2.0 presets are forward compatible with the fu-
ture books of this series and will be updated should the
need arise (changes in Photoshop, operating systems or
adding additional functionality as the driver improves).

¢ There are two actions that come with the Oz 2.0 presets:
the BP/MP/WP action for finding black, mid, and white
points and the Midtone Contouring action, which I will
discuss toward the end of this chapter. You need to load
both these actions into Photoshop.

NOTE: If you do not have some of the software or actions
that I have installed on my machine (like Genuine Fractals,
SharpenerPro, Silver Efex Pro, etc.), then those areas in my
presets will not work for you.

¢ As presets or actions change (should I find a better or
more efficient way to do things), [ will post them on the
download page and send an email to all those on the
Welcome to Oz/Acme Educational mailing list. (You are
automatically signed up for this when you log into the
download page for this book.)

¢ DPlease understand that these are my presets, and al-
though I had considerable help from Wacom to create
them, they are NOT a Wacom-supported product.

¢ First generation 21” Cintiq express keys settings are in
the PDF that is included in the OZ_2.0_PRESETS folder.

Should you want to know more about how to make your own
set of presets, or customize those that I have provided, go to
http://www.wacom.com/downloads/videos.php

To install the Oz 2.0 tablet settings:
1. Download the OZ_TS.zip file located in the CHOS folder.

2. Once you have opened the zip file, double-click on the
0Z_2.0_TS kys. (This automatically loads the updated key-
board shortcuts into Photoshop.)

3. Double-click on the 0Z_2.0_TS file. (This automatically
loads the OZ_2.0 tablet presets.)

Screen Capture Breakdown of the Express Keys,
Touch Strips, Radial Menu, and Sub-Menus.

What follows is the breakdown of the Oz 2.0 presets.

1. Pen—The pen is set up with Option assigned to the front
of the toggle switch and the back of the toggle switch set to
launch the Radial menu.

NOTE: The reason for this is that the Oz 2.0 preset is de-
signed to work on all tablets and some do not have express
keys. Also, the redundancy that exists in Oz 2 is there by de-
sign. Again, these are my presets. Feel free to innovate and
change things so that they work best for you. Feel free to
send me suggestions at Vincent@versacephotography.com.
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2. Dominant Hand Express Keys

*

Show Settings—This will show you (on the screen) all of
the settings assigned to the express keys. Click this if you
want to know what the express keys do.

Radial Menu—Tlaunches the Radial menu from an ex-
press key.

Precision mode—causes the curser to move in precision
mode.

Display toggle—This is for setting up the monitor for
dual monitor viewing (See The Sliger Multiple Monitors
Methodology with a tablet or Cintiq).

Shift—Use this when you need to modify an operation
with the Shift key.

Command / Control—Use this when you need to modify
an operation with the Command / Control key.

Opt / Alt—Use this when you need to modify an opera-
tion with the Opt / Alt key.

Pan Scroll—Use this when you want to pan or scroll.

3. Dominant Hand Touch Strip (Toggle)

*

Undo / Redo (Position 1)—This allows you unlimited
undos and redos based on the direction that you move
your finger on the touch strip.

Increase / Decrease all Sliders (Position 2)—allows you to
decrease or increase amounts based on the direction that
you move your finger on the touch strip.

Brush Size (Position 3)—allows you to decrease or in-
crease brush size based on the direction that you move
your finger on the touch strip.

Blend Modes (Position 4)—allows you to dial through all
of the blend modes based on the direction that you move
your finger on the touch strip.

4. Non-Dominant Hand Express Keys

* o o

*

Save—saves the document.

Save As—allows you to “Save As” a file.

Print—launches the Print dialog box.

Open—allows you to open a file.

Full Screen—Clicking on this rotates through the Full
Screen modes.

Launch Actions—launches the Actions main panel.

Die Adjustment—turns off the ever-reappearing Adjust-

ments panel.

NOTE: I added this to address a User Interface (UI) design
bug introduced in CS4 that has yet to be addressed. The
problem is that no matter how many times you turn off the

adjustment panel, if you use any adjustment layer, the panel

always reappears. This key just makes it easier to get rid of

it.

5. Non-Dominant Hand Touch Strip (Toggle)

*

Screen Zoom (Position 1)—utilizes the screen zoom
functionality for both Mac and Windows 7. (See sidebar
in Chapter 2: Under a Magnifying Glass: Mac OS vs. Win-
dows OS, page 158)

Increase / Decrease all Sliders (Position 2)—allows you to
decrease or increase amounts based on the direction you
move your fingers on the touch strip.

Brush Size (Position 3)—allows you to decrease or in-
crease brush size based on the direction you move your
fingers on the touch strip.

Blend Modes (Position 4)—allows you to dial through all
of the blend modes based on the direction you move your
fingers on the touch strip.

18
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6. Main Radial Menu—This is the main menu for the Radial
menu. The presence of a white triangle in the menu segment

means there is additional functionality in a sub-menu.

Image—Tlanches the Image sub-menu.

Fade Effects—launches the Fade Effect dialog box.
Layers—launches the Layers sub-menu

Color Opacity—launches the Colors Opacity sub-menu.
New Window For.....—creates a new window of the
current file, which is useful for working with multiple
screens and for layer mask optimization.

Run Apps—Tlaunches the Run Apps sub-menu.
Adjustment—TIlaunches the Adjustments sub-menu.

7. Layers Sub-Menu

New Layer—creates a new layer.

Command + / Ctrl + J—duplicates a layer or section.

The Move—merges all visible layers into one while pre-
serving (not flattening) all of them.

Convert Smart Filters—converts a layer into a Smart
Filter.

New Layer Group—creates a new layer group or layer set.
Fill Foreground—fills with foreground color.

Fill Background—fills with background color.

8. Actions & Filters Sub-Menu

*

Midtone Contouring—resets the foreground and back-
ground colors to their default settings.
WP/MP/BP—Ilaunches an action that sets up White,
Black and Midpoints. (The action is located in the same
folder as the OZ_2.0_PRESETS.)

Render Lighting Effects—launches the Adobe Photoshop
Render Lighting Effects filter.

CEP V V Edition—Launches the Nik ColorEffects Pro 3.0
Versace Edition filters.

FocalPoint 2.0 — Launches FocalPoint 2.0

Genuine Fractals—launches Genuine Fractals.

*

*

Nik filters—brings up the Nik Software menu for all of
the installed Nik Software.

onOne filters—brings up the onOne Software menu for
all of the installed onOne software.

9. Color Opacity Sub-Menu

*

* ¢ o o

*

11.

Default Colors—resets the foreground and background
colors to the their default settings.

50%—sets brush opacity to 50%.

100%—sets brush opacity to 100%.

Brush Pallet—launches the Brush Pallet.

Toggle Fore / Back—toggles the position of the back-
ground and foreground colors.

. Run Apps Sub-Menu

Capture NX2—launches Capture NX2 (if installed).
Adobe Lightroom—Tlaunches Adobe Lightroom (if
installed).

Aperture—launches Adobe Aperture (if installed).
iPhoto—Ilaunches iPhoto (if installed).

Microsoft Word—Ilaunches Microsoft Word (if installed).
iShowU—launches iShowU (if installed).
Safari—launches Safari (if installed).

EyeOne Match—launches X-Rite’s EyeOne Match (if
installed).

Adjustments Sub-Menu

Free Transform—Ilaunches Free Transform.

Hue/Sat Adj Layer—creates a Hue and Saturation adjust-
ment layer.

Vibrance Adj Layer—creates a Vibrance adjustment layer.
Curves Adj Layer —creates a Curves adjustment layer.
Threshold Adj Layer —creates a Threshold adjustment
layer.
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12. Image Sub-menu

Open—allows you to open a file.
Save—allows you to save a file.

* & o

Save As—allows you to Save As a file.

*

Flatten—allows you to flatten a file.

¢ Convert to sRGB - converts a file to the sSRGB colorspace.

¢ Convert to Adobe RGB—converts a file to the Adobe
RGB colorspace.

¢ Convert to LAB—converts a file to the LAB colorspace.

+ 8bit—converts a file to the 8-bit colorspace.

Turning On the On Screen Keyboard

You can have an onscreen keyboard that allows you to use the
pen to enter in characters and text.

Mac OS
1. Go to Systems Preferences and click on Keyboard.

2. When the Keyboard dialog box comes up, click on
the Show Keyboard & Character Viewer in the menu bar

Ann Keyboard
(L] Q D
{Fievboard~ Keyboard shortcuts
Key Repeat Rate Delay Until Repeat

—_—

slow Fast 0 Long shon

(1] Use all F1, F2, etc. keys as standard function keys
ed, press the Frn key to use the special

T —
(Modifier Keys )

Set Up Bluetouth Keybuard... ) (7)

FiGure 5.8.1 The Show Keyboard & Character Viewer option

& Thu4:07PM Q

FIGURE §.8.2 The Keyboard icon in the menu bar

(Figure 5.8.1). The Keyboard icon will appear in the menu bar
(Figure 5.8.2). Click on it whenever you want the onscreen
Keyboard.

Windows 7 OS

Type without using the keyboard (On-Screen Keyboard)
On-Screen Keyboard lets you type and interact with your com-
puter using an alternative input device like a switch, rather
than the physical keyboard. On-Screen Keyboard displays a
visual keyboard with all of the standard keys. You can select
keys using the mouse or another pointing device, a small
groups of keys, or just one key, depending on how you set up
On-Screen Keyboard.

There are two ways to start On-Screen Keyboard:

1. Start On-Screen Keyboard from Quick Access to common
tools for use in the current session, or

2. Turn on On-Screen Keyboard so that it automatically
starts each time you log on.

To start the On-Screen Keyboard for the current session fol-
low these steps:

1. Go to the Start menu > the Control Panel > Ease of Access
> and the Ease of Access Center.

2. Once in the Ease of Access Center, go the Quick Access to
common tools and select Start On-Screen Keyboard.

NOTE: You can access the Ease of Access Center by pressing
the Windows logo + U on your keyboard. Then you can start
the On-Screen Keyboard by pressing Alt + K.

To turn on the On-Screen Keyboard each time you log-in to
your computer follow these steps:

1. Under the Explore all settings menu, select Use the com-
puter without a mouse or keyboard.

2. Under Type using a pointing device, select Use On-Screen
Keyboard, and then select Save.
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FOUR: Fractal Scaling the Edge by Definition

Think not of what you see. But what it took to produce what it is you

see.

—Benoit Mandelbrot
“How do make you make your big prints look so good?” This
is one of my most frequently asked questions. For the past 12
years, [ have scaled fractally. The software that I use to do this
is Genuine Fractals and I have been involved with this tech-
nology since its inception. In my opinion, there is no better
way to scale, so 100% of my images are stored and scaled this
way. Let me explain why this is so (without too much math-
ematical detail).

Benoit Mandelbrot, the father of modern Fractal Geometry
coined the word “fractal”. It comes from the Latin “factus”
which means jagged and broken. In a sense, Mandelbrot
discovered fractals while working for IBM when tasked with
coming up with a way to preserve data being transmitted over
phone lines.

Many people think that mathematicians are very different
from artists. I have come to realize that art is mathematics,
and that artists and mathematicians are just using a different
language to explain or describe the same things. Mandelbrot’s
discoveries were not merely a bunch of equations, they gave
us a way to mathematically describe what we see around us.

FIGURE §.9.1 Hokusa’s Breaking Wave Off Kanagowa

Fractals have been observed in cave paintings and can be seen
in all forms of native American art. The 17th century Japa-
nese painter, Katsushika Hokusa, was known for his inclusion
of fractals in his paintings, even though no one recognized

at the time what they were. (Hokusa’s most famous paint-
ing is Breaking Wave Off Kanagawa Figures 5.9.1 and 5.9.2).
Fractals and fractal geometry are seen in the underlying struc-
ture of much of the natural world. Fractals are seen in our
lungs, kidneys, and blood vessels. They are present in plants,
weather systems, and the rhythms of the heart. Even the an-
tenna of your cell phone is based on a fractal design.

Formally, a fractal is a geometric shape that is self similar and
has a fractional (fractal) dimension. Fractional dimension?
Self similar? Let me start with the concept of self similarity,
which is at the core of how the Genuine Fractals algorithm
works. (For brevity, [ am going to omit a discussion of frac-
tional dimension.)

In mathematics, self similarity means that a whole object is
exactly, or approximately, similar to a part of itself (i.e., the
whole has the same shape as one or more of its parts). Es-
sentially, the object will look the same at all scales. As you get
closer to it or move farther away, it appears similar to what it
looked like at the original scale. For photographers, it is like
zooming in from far to near to macro and seeing essentially
the same thing. A straight line is self similar in that no matter
what scale you look at it, it is still a straight line.

FIGURE §.9.2 A detail from Breaking Wave Off Kanagowa
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FIGURE g.10.1 A field of Sierpinski Triangle

Fractals

FIGURE §.10.2 Zoomed in, the figure remains

consistent

FIGURE §.10.3 Zoomed in even further, the

figure is made up of even more triangles

Fractals are things that when broken up into smaller and
smaller fractions, are endless repetitions of something that
can be scaled upwards or downwards without changing its es-
sential design. Let me show you this by exploring the famous
Sierpinski Triangle Fractal. If you look at a field of Sierpinski
triangles, it looks like just that—a field of small triangles
(Figure 5.10.1). But if you zoom into one area, you see that
the area you zoomed into is the same as the large field at
which you were just looking (Figure 5.10.2). If you zoom to
the new field, again you see that that field is made up of even
more of the same triangles (Figure 5.10.3). The whole of a
fractal looks just like any smaller part of it. This is because
they are self similar. Now that you have some understanding
of the concept of self similarity, I will show you how this can
be applied to the process of scaling images.

How to Make a Sierpinski Triangle
1. Create an equilateral triangle (Figure 5.11.1).

2. Duplicate the equilateral triangle twice, and move one of
the triangles to the right and one to the top (Figure 5.11.2).

3. Duplicate this group of three triangles twice, again mov-
ing one of iterated groups to the right and one to the top
(Figure 5.11.3).

4. Duplicate this group of triangles twice, again mov-
ing one of iterated groups to the right and one to the top
(Figure 5.11.4).

FIGURE g.11.1 A single triangle
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FIGURE g.11.2 Three triangles

AAAA

FIGURE 5.11.3 Nine triangles
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FIGURE g.11.4 Twenty-seven triangles to form the
Sierpinski Triangle

The Hidden Dimension gf Fractals

To find out more about fractals and the way they impact our
everyday lives, these are the URLs of the sources that [ used to
write this section.

http://en.wikipedia.org/wiki/Self-similarity

http://www.pbs.org/wgbh/nova/physics/hunting-hidden-
dimension.html

http://www.math.umass.edu/~mconnors/fractal/similar/
similar.html

http://math.rice.edu/~lanius/fractals/dim.html

Genuine Fractals are Magical, But Not Magic

Any sz{ﬁpjciently advanced technology is indistinguishab]efrom magic.
—Arthur C. Clarke

We have all watched scenes from movies like Bladerunner and
television shows like CSI, where a grainy image from a secu-
rity photo is enlarged and the reflection in the victim’s eye
not only reveals the killer, but the results look so amazing that
you feel as if you were there when the crime was committed.
This is pure science fiction. In an image capture, you cannot
create detail where there was none before, so to believe this is
possible is an unrealistic expectation.

When scaling an image, there two things that you need to
know: how big a print you want and the optimum file resolu-
tion for the printer that is making the print.
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NOTE: This range is based on the optimum native resolu-
tion of an Epson printer which is 360ppi. When determining
file resolution, it is advisable to work in multiples of 90,
because it is easier math for the printer driver to calculate.
This will lead to prints that will have less unwanted blur and
less aliasing. In theory, there are three optimum file PPI res-
olutions for an Epson printer: 180ppi, 270ppi, and 360ppi
with 360ppi offering the best possible prints. A common
mistake is to set the resolution of the file to the resolution
of the printer (e.g., 2880ppi file resolution for a 2880dpi
printer). In all but a few special printers, this will result in

huge files that will not print well, if at all.

The size of your print is limited by the width of your printer.
File resolution is more complicated to determine, because it
is determined by the density of the pixels for a given distance
(usually measured in pixels or dots per inch). Most modern
inkjet printers print anywhere from 1200 to 5760 dots per
inch (DPI). Inkjet printers’ dots are so small that measuring
by size (or diameter) on the media is inaccurate. They have to
be measured by an extremely small volume called picolitres,
which are tiny round droplets. With these tiny round droplets,
all a printer needs is relatively few (4-8) ink colors to repro-
duce one square pixel in your image that could be any of mil-
lions of colors.

Scaling an image to larger than the native file size of the
source file requires that new pixels be created. This process

is called interpolation, upsampling, or resampling. The most
common and most widely used algorithm is bicubic interpola-
tion. In Photoshop, in addition to standard bicubic there are
two additional variations of bicubic interpolation; bicubic
smoother and bicubic sharper. While the bicubic technique is
fast, it is not accurate or precise, and because it does not dis-
tinguish edges, there is a uniform loss of sharpness and detail
across the image.

NOTE: Adobe recommends bicubic (smoother) for upsam-
pling and bicubic (sharper) for down sampling. These set-
tings were created to better refine the artifacting caused by

the bicubic interpolation process.

On the other hand, fractal scaling (as implemented by Genu-
ine Fractals, or Perfect Resize as it is now called) is fundamen-
tally different from bicubic or other algebraic interpolation
methods. Genuine Fractals converts the pixels to a fractal,
and then iterates its self similar components and “grows “the
image. Fractal scaling samples nearby blocks of pixels and
compares them to smaller versions of the original image to
find the repeating natural patterns, or fractals. Then, it cre-
ates a mosaic of these patches to create a larger version of the
original. By iterating this process many times, the character-
istics of the image (like edges, smooth areas, and textures)

are reinforced when creating a larger version of the source
file. Noise is de-emphasized and sharp details are maintained.
The major downside to this approach is that all of the number
crunching that is required to fractally scale an image may take
a bit longer than the single pass interpolation methods like
bicubic interpolation.

The size of a print that can be made with Genuine Fractals
software is image dependant. If your original image is sharp,
has good details, and little noise, you could go as large as
1000%, or ten times the original size. For example, an original
file that is 8"x10” could be resized to 80"x100”. You must con-
sider, however, the image quality at that size and that is much
more subjective. In addition, viewing distance, with any form
of interpolation, is always a big part of the equation. The
general rule for determining a good viewing distance is 2 to 3
times the diagonal dimension of the print, e.g., for an 8"x10”
it would be 25.67-38.4". For the 80”x100”, you are talking
about 21°-32" away. Although that seems like a long distance,
remember that the image is almost 7'x10’.

The reason that viewing distance is an important part of how
you scale is because images are perceived in several ways;
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color, tonality, and sharpness. Non-fractal interpolation
techniques, such as the bicubic algorithms, usually maintain
color and tonality, but sacrifice sharpness by “inflating” the
image uniformly. The image still looks familiar (like the origi-
nal source file), but it is not crisp. Depending on the amount
of interpolation needed, this is frequently severe and very
noticeable even at standard viewing distances. The power of
Genuine Fractals and the reason that I use it on 100% of my
images is because it maintains the color, tonality, and sharp-
ness of an image at all sizes. This means that the image will
always look the same when viewed at the proper distances.

It is unrealistic to assume, however, that the details of an
image viewed as an 8x10 will be equivalent to one viewed as
an 80x100, whether or not it was created by Genuine Fractals
or any other interpolation algorithm. Genuine Fractals will
maintain the edges, which perceptually make the image sharp,
but it cannot create detail where there was none in the origi-
nal capture. When the shutter is pressed, a finite amount of
information is captured. A good way to think about this is to
look at an insect on a leaf. If you look at it with a magnifying
glass, you will see more detail than you did than when look-
ing at it with the naked eye. If you take a digital photograph
of that same insect and look at it on your computer screen
and zoom in past 100%, you do not see any more detail. The
amount of information you see is limited by what the camera
captured. Genuine Fractals works the same way; it takes the
finite amount of detail available and increases it in size, but
cannot it create new detail.

Because I believe that every picture tells a story, included in
the folder for this lesson is the full resolution file that was
created for the example pictures. In that file, you can see all
the different ways to upsample. First- the “stair” interpolation
approach (using standard bicubic interpolation in 10% incre-
ments until the image is up-sized to the desired end point),
second- up-sampling just using bicubic smoother, third- bicu-
bic sharper interpolation, and finally Genuine Fractals. [ have
ordered the examples, I my opinion, from worst (stair interpo-
lation) to best (Genuine Fractals).

Compare the image after bicubic 10% stair interpolation
(Figure 5.12.1), after the bicubic smoother interpola-

tion (Figure 5.12.2), after bicubic sharper interpolation
(Figure 5.12.3), and after Genuine Fractals (Figure 5.12.4).
All Figures are on the next page.

The artifacts that are created by upscaling bicubically (without
using smoother or sharper) result in a blurrier image than you
might want, and the artifacts that are created by down scaling
are overly emphasized sharpness of edges. From my personal
experience, and this simply may be the outcome of the way [
process my images, [ have found that if I am forced to use bi-
cubic interpolation rather than Genuine Fractals, I think that
I get a better looking image upscaling with bicubic sharper.
advice you to try both and see what you think works best with
your images.

TheWhy to of My How 25



FIGURE §.12.3 Bicubic Sharper interpolation FIGURE §.12.4 Genuine Fractals interpolation
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FIVE: Make the Print Pop

Everything that you have done in this book has been to
bring you to these last few paragraphs. After you have done
as much as you can to bring your image as close as possible
to your vision of the experience that you had when you were
taken by the moment and clicked the shutter, it is time to
make a print. Because the printer is a default device and the
print is only as good as the file you send to the printer, you
have one more tool that will help you achieve that goal. This
tool is a technique developed by R. Mac Holbert of Nash Edi-
tions that he calls, “Midtone Contrast.” I use this on 100%
of my images and it is the last thing that I do before I tell the
printer to print.

FIGURE §.13.2 After Midtone Contrast

Adobe took Mr. Holbert’s technique and used it as the
basis of Photoshop’s Clarity tool. I have created an action
(located in this chapter’s folder) that you can load into Pho-
toshop that I call, Midtone Contouring. The reason for this
slight name change is to differentiate it from Mr. Holbert’s
action because I have added a layer mask and set the layer’s
default opacity at a different level than he did.

How this is done is by using a large radius (50 pixels) of
edge sharpening, and appling the High Pass filter on a de-
saturated copy of the final layer (so that you do not introduce
any sharpening artifacts to the overall color). Then, set the
layer to the Overlay blend mode. Last, target just the midtone
area of the image using the Blend If sliders (set to 50/70 and
185/205) that are found in the Layers Style dialog box. (See
the Blend If sidebar.) Mr. Holbert recommends that when you
apply Midtone Contrast, that the amount of the effect is at
alayer opacity between 20 and 40% — and closer to 20 than
40%. (I have set the action to set the layer opacity at 30%.)

Compare the image before applying Midtone Contour-
ing (Figure 5.13.1) and after applying Midtone Contouring
(Figure 5.13.2).
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FIGURE 5.14.2 The Blend If sliders in the shadows
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FIGURE §.14.3 The Blend If sliders in the highlights

Blend b" ..

Some of the scarier tools in Photoshop are the Blend if
sliders. However, some of the more useful tools in Photoshop
are the Blend If sliders. This functionality allows you target
(hide or show) specific areas in an image without the need for
brush work or masking. The Blend if sliders are located in the
Layer Styles dialog box that you can access by double-clicking
on a layer or by choosing it from the Menu drop-down menu
(Layer > Layer Style > Blending Options) There are two slid-
ers: one called This Layer that controls the current or active
layer as well as how it blends with what is below it, and an-
other called Underlying Layer that controls the layer below
the active one as well as how it blends with the active layer
(Figure 5.14.1). The sliders are on a scale from 0 to 255, and
the default for the two sliders is 0 and 255 points respec-
tively. The power of the Blend If sliders comes in your ability
to separate them (Figures 5.14.2 and 5.14.3), which not
only allows you to target specific areas of the image, it also
allows you to fine tune the way the effect will interact with
the image as well as the place on the 0 to 255 scale (ramp or
“feather”) the effect will fade in as well as fade out out.
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The End of the Beginning

I never think of the future. It comes soon enough.

—Albert Einstein
Before you ever press the shutter, there must be something
that moves you to do so. If you are not moved, you will not
move others. See the image in your mind’s eye in its com-
pleted form, and make your captures so that the experience
of time will be an element in your final print. Then, when you
take your captures to your computer, try to re-create your
original vision, removing everything that does not conform
to that vision. Do not try to make a memorable image out of a
capture made casually, even if it was a happy accident.

If you have read all that has preceded this, you know that a
still camera’s limitations are also its power. John Paul Caponi-
gro has said, “The camera is what [ use to hold the world still.”
And this is not “hold” in the sense of tying something down.
That is too often the case with people who feel that all photo-
graphs must be posed and the subject must stay completely
still. “Sit, move your head to left. ... No, too much, okay, hold
that. Place your hand under your chin. ... Stop. ... Hold that,
don’t move.” Shooting that way produces images so devoid of
life and time that they are eminently forgettable.

You should want to create images that feel as if they are about
to move or were caught as if they were already in motion. One
more time: A still photograph is called a still photograph be-
cause the picture doesn’t move, not because the objects in the
picture are not in motion. You can capture motion with still-
ness and, in that moment, hold time still, but yet experience
the feeling of its passing.

There is a quote often attributed to the philosopher Sgren
Kierkegaard: “Life must be lived forward, but can only be
understood backward.” If your final print encompasses the
experience of life moving forward, that image will allow your
viewer to understand it backward.

NOTE: When working on a Mac, Render Lighting Effects

is only available in the 32-bit version of Photoshop CS5.
Throughout the writing of Welcome to Oz 2.0, I was working
in the 32-bit version of Photoshop CS5 in order to work with
third-party plug-ins that had not yet been updated, but they
have since been updated. This caveat about Render Lighting
Effects did not make the printed version of the book but is

very important to know.
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